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1 Introduction
Fine tuning SAP Enterprise Portal is a continuous process aimed at increasing the performance of
processes in the portal environment.
The goal of this document is to provide tuning guidelines for Enterprise Portal to partners, consultants,
and implementers.
It describes configuration settings, and provides procedures on how to set various parameters for your
operating system, Java Virtual Machine (JVM), SAP J2EE Engine Cluster, the portal database, the
browser, and the LDAP directory service, that lead to increases in the performance of processes in
the Enterprise Portal cluster environment.
Settings are presented as independent configurations, and modifying each configuration separately
leads to an increased performance of processes within an area of the portal.
For maximum increase in performance, it is recommended that you implement all modifications
discussed in this document.

In different environments and systems, you may have different needs and expectations, and
in addition, obtain different results. We highly recommend that you monitor the improvements
achieved after making the configuration changes.
Furthermore, tests to increase the performance of the portal processes are continuously in progress.
Therefore we recommend that you visit our Web site for up-to-date information on tuning guidelines
for Enterprise Portal at:
http://service.sap.com > Enterprise Portal 6.0 > Documentation & More > How-To Guides
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2 Tuning the Operating System
Thread management changes are highly dependent on operating system (OS) resources. These
changes bring about different results in different machine configurations.
To achieve optimal performance, you must configure each operating system with its required set of
parameters.
For detailed information on how to implement the OS dependencies, refer to SAP Software on UNIX:
OS Dependencies, at: http://service.sap.com/netweaver and follow the link SAP NetWeaver in
Detail -> Solution Life-Cycle Management -> Installation -> Installation & Upgrade Guides -> SAP Web
Application Server -> Release 6.20
Check also SAP Note 492222, SAP Software on UNIX: OS Dependencies, for updated kernel
parameters.
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3 Tuning the Java Virtual Machine
This section contains Java Virtual Machine (JVM) command line properties to add to the configuration
files of the SAP J2EE Engine Cluster server.

3.1

JVM Configuration Files

The following files contain JVM command line properties for the SAP J2EE Engine server:
•

cmdline.properties

•

go.bat

If you are using UNIX Daemon, add the settings in the SAP J2EE Engine Config Tool window. To
open the SAP J2EE Engine Config Tool:
•

Run the file configtool (config.bat in Windows) in the SAP J2EE Engine configuration folder at:
/usr/sap/<system name>/j2ee/j2ee_<system number>/configtool.

If you are running the SAP J2EE Engine Dispatcher node manually with the Server node starting
automatically, add the settings to the file in the path:
<J2EE Engine folder>/cluster/server/cmdline.properties
If you are running the SAP J2EE Engine Server node and the Dispatcher node manually, add the
settings directly to the file in the path:
<J2EE Engine folder>/cluster/server/go.bat
The table below shows the parameters on heap size and garbage collection (GC) to add to the JVM
configuration files for SAP J2EE Engine server.
Settings

Actions and Notes

Heap Size

Heap size is the memory allocated to the Java Virtual Machine for use at run
time.
The heap size used by the Java Virtual Machine is a function of the number of
running and cached objects an application needs to use, and the available
amount of memory to the machine.
•

Enterprise Portal 6.0 requires a minimum heap size of 512MB.

•

In production environments, the recommended heap size is 1.5GB.

Make sure that the following properties have the same heap size value. If these
have not been defined, add them to the JVM configuration files:
-Xms<HEAP SIZE>
-Xmx<HEAP SIZE>
-Dmemory.manager=<HEAP SIZE>
For example: -Xms512M
The maximum amount of memory allowed on 32 bit UNIX systems is 1.5GB. In
64 bit systems, the maximum value allowed is 4GB. A heap size larger than
1.5GB is not recommended.

The installation program for SAP Enterprise Portal 6.0 SP1,
automatically configures this JVM setting for the SAP J2EE Engine
server.
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Settings

Actions and Notes

Heap Size with
Multiple VMs

A single SAP J2EE Engine Cluster Server node is capable of utilizing
approximately 1.5 CPUs. It is recommended to ‘scale in’ on the same host, by
adding SAP J2EE Engine Cluster Server nodes.

(on the same
host)

The SAP J2EE Engine Cluster Server nodes on the same host go through a full
garbage collection (FGC) cycle at the same time. Simultaneous garbage
collection (GC) on several Server nodes consumes a lot of CPU.
To avoid simultaneous GC cycles, configure the heap size on each Server
node with a different value, as doing so improves performance by distributing
garbage collection periods.
For example:
Distribute the heap size for three SAP J2EE Engine Server nodes on a
4-way machine as follows: 512MB, 750MB, and 1.2GB.
This configuration improves performance better than configuring each
Server node with 1GB.
For information on the portal infrastructure, refer to the guide SAP Enterprise
Portal Technical Infrastructure in the zipped package, EP6.0 SP1 Installation
Guide (Portal, CM, TREX, Unification), at: http://service.sap.com, and
navigate to Enterprise Portal 6.0 > Documentation & More > Installation.

New Size

This parameter configures the size of a “new” generation in the JVM memory
heap. The default value for this parameter is 32MB.
Objects that go through several collections and survive are moved to the “old”
generation leaving room for newer objects. Objects that populate the “new”
generation have not gone through a garbage collection cycle yet.
The value for a new size is related to the value for the heap size you have
defined.
•

For 512MB-999MB, the recommended New Size is 64MB.

•

For 1GB and above, the recommended New Size HEAP/3.

The installation program for SAP Enterprise Portal 6.0 SP1,
automatically configures this JVM setting for the SAP J2EE Engine
server.
Perm Size

This parameter configures the size of the “permanent” generation memory
space that is allocated outside the JVM memory heap.
Objects that populate this generation never go through a garbage collection
cycle. Some portal applications, such as Content Management (CM) keep a
large number of “permanent” objects in memory for fast reference.
The value for perm size is related to the value for the heap size you have
defined.
•

For 512MB-999MB, the recommended Perm Size is 64MB.

•

For 1GB and above, the recommended Perm Size 128MB.

Configure the perm size by adding the following parameters to the JVM
configuration files:
-XX:PermSize=<PERM SIZE>
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Settings

Actions and Notes
-XX:MaxPermSize=<PERM SIZE>
For example: -XX:PermSize=128M

The installation program for SAP Enterprise Portal 6.0 SP1,
automatically configures this JVM setting for the SAP J2EE Engine
server.
Disable explicit
garbage
collection

Explicit calls invoking the garbage collector should be disabled by default.
Disable explicit GC by adding the following parameter to the JVM configuration
files:
-XX:+DisableExplicitGC
Relevant where the SAP J2EE Engine has a memory manager that handles
GC calls independently.
For more information, refer to the section on Thread Manager Settings.

The installation program for SAP Enterprise Portal 6.0 SP1,
automatically configures this JVM setting for the SAP J2EE Engine
server.
Soft Reference
Policy

This parameter configures the number of soft references that can stay alive on
the heap. Soft references are used by applications to keep old objects from
being collected for future use.
On production systems that host a large number of concurrent users, reduce
this value in order to free heap space for dynamically allocated objects. For
such configuration, a value of 1 Millisecond per MB is recommended.
Configure this size by adding the following parameter to the JVM configuration
files:
-XX:SoftRefLRUPolicyMSPerMB=1
For this parameter, start with a value of 1(one).

You must configure this JVM setting for the SAP J2EE Engine.
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3.2

JIT Server Compiler

Configure the server JIT compiler to be used instead of the client virtual machine (VM). This VM
setting has several performance improvements.
•

Add the following parameter at the beginning of the JVM command line in the JVM
configuration files:
–server

Important: this parameter is recommended for use only on multi-CPU systems, and with
JDK1.3.1_08 and above only.

The installation program for SAP Enterprise Portal 6.0 SP1, automatically configures this JVM
setting for the SAP J2EE Engine server.
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4 Configuring SAP J2EE Engine Cluster 6.20
This section provides procedures on how to configure SAP J2EE Engine to make sure that the portal
runs in a highly optimized environment. As SAP J2EE Engine Cluster is a separate platform on which
the Enterprise Portal runs, you must configure it to increase the performance of the processes used
by the Enterprise Portal.
For additional information on tuning SAP J2EE Engine Cluster 6.20, refer to the document How to
Tune SAP J2EE Engine 6.20 v3.0 available at: http://service.sap.com/webas, and navigate to Tools
& Demos Î How-To Guides.

4.1

Cluster Setup for Enterprise Portal

The portal cluster environment depends on the proper setup and configuration of SAP J2EE Engine.
You can configure properties of SAP J2EE Engine in the SAP J2EE Engine Config Tool window.
To open the SAP J2EE Config Tool window:
•

Run the file configtool (config.bat in Windows) in the folder:
/usr/sap/<system name>/j2ee/j2ee_<system number>/configtool.

The following properties must be configured on each machine running SAP J2EE Engine Cluster:
Property

Actions and Notes

ClusterHosts

Defines a list of other SAP J2EE Engine Cluster hosts in the cluster
environment to which the local SAP J2EE Engine Cluster host must
connect.
•

In the SAP J2EE Engine Config Tool window, open:
Dispatcher Î managers Î ClusterManager Î ClusterHosts
It is used together with the property RepeatToConnect.

Do not change the default, as this setting is automatically configured
when you perform additional SAP J2EE Engine installations in the
portal cluster.
RepeatToConnect

This property takes a ‘true’ or ‘false’ value. When the value is ‘true’ the
local cluster node attempts to connect to other hosts, and waits for the
connection. When the value is “false,’ it does not wait to connect.
•

In the SAP J2EE Engine Config Tool window:
Dispatcher Î managers Î ClusterManager Î RepeatToConnect
It is used together with the property ClusterHosts. The two
properties, RepeatToConnect and ClusterHosts, can guarantee
consistent connection and failover recovery of the cluster. This joint
action is effective when starting the cluster; after, the cluster
connectivity is everyone-to-everyone.

Do not change the default, as this setting is automatically configured
when you perform additional SAP J2EE Engine installations in the
portal cluster.
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Property

Actions and Notes

LocalLoadBalancing

This property takes a ‘true’ or ‘false’ value.
When the value is false, SAP J2EE Engine cluster enables the particular
Dispatcher to manage the load (of HTTP requests) on all Server nodes
in the cluster across the network. A value of ‘true’ enables a Dispatcher
to load balance HTTP requests locally with the Servers running on the
same host.
•

In the SAP J2EE Engine Config Tool window, set the value to true:
Dispatcher Î managers Î ServiceManager Î LocalLoadBalancing

DependentElement

This property defines the Server node synchronization method of the
DBMS service to be either Primary, or non–Primary.
This property takes a ‘true’ or ‘false’ value. When the value is false, the
synchronization method for the DBMS service of the particular Server
node is flagged as primary. This allows the Server node to keep a local
copy of the SAP J2EE Engine deployment database. All other Server
nodes can either reference the database without keeping a local copy, or
update their local copies of the database after recovering from a failure.
A value of ‘true’ configures the node to be a dependent DBMS service
node, that reads the deployment database from a central node.
•

In the SAP J2EE Configuration Tool window, set the value of this
property to true:
Dispatcher Î managers Î ClusterManager Î DependentElement

For additional information on the portal landscape and cluster infrastructure, refer to the guide SAP
Enterprise Portal Technical Infrastructure in the zipped package, EP6.0 SP1 Installation Guide (Portal,
CM, TREX, Unification), at: http://service.sap.com, and navigate to Enterprise Portal 6.0 >
Documentation & More > Installation.

4.2

Thread Manager Settings

This section describes the recommended changes to the Thread Manager settings of SAP J2EE
Engine Cluster.

The How to Tune SAP J2EE Engine 6.20 v3.0 document recommends that you change the
Thread Manager settings. Refer to the document How to Tune SAP J2EE Engine 6.20 v3.0
available at: http://service.sap.com/webas, and navigate to Tools & Demos Î How-To
Guides.
Follow the guidelines below when changing the Thread Manager settings for portal cluster:
•

The number of threads that each machine is capable of supporting depends on the amount of
available memory, CPU, and other system resources.
You need to conduct performance tests, to obtain the correct settings for a specific machine,
as the settings in the document, How to Tune SAP J2EE Engine 6.20 v3.0, are not optimized
for every machine.

•

The portal itself contains a portal runtime (PRT) setting called loadlimit.requests. This
property controls the maximum number of concurrent requests from the browser to the portal,
at a time.
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The value of this property must be the same as the value of the MaxThreadCount property of
the SAP J2EE Engine thread manager. Both are set to 100 by default. See also PRT Thread
Management.

4.3

Optimizing SAP J2EE Engine Log Files

Log files enable you to track possible unstable conditions of the portal during development and testing
stages. An out-of-the-box portal installation has various log files containing portal runtime information.
In a production environment, these log files occupy portal resources, and can have an effect on the
overall performance of the portal. Therefore, we recommend that you disable writing to all the log files
in a production environment.
To change SAP J2EE Engine log levels:
1. Run the file configtool (configtool.bat in Windows) in the SAP J2EE Engine folder at:
/usr/sap/<system name>/j2ee/j2ee_<system number>/configtool.
In the SAP J2EE Engine Config Tool window, change the following parameters:
•

Dispatcher Î managers Î LogManager Î LogLevel = 0

•

Server Î managers Î LogManager Î LogLevel = 0

•

Server Î services Î http Î EnableLoging = false

•

Server Î services Î PRTBridge Î EnableLoging = false

2. From the File menu, select Apply to save changes.

4.4

Enabling HTTP Compression for SAP J2EE Engine 6.20

The SAP J2EE Engine contains an HTTP compression feature that improves performance by
reducing network traffic.
•

Use this feature to disable compression for portal pages that need to work without
compression.

Important: To use this feature with an installation of Enterprise Portal 6.0, you need SAP
J2EE Engine Cluster 6.20 Patch Level 12 or higher, because it supports conditional
compression.
To configure HTTP compression:
•

Run the file configtool. For more information, see the section Thread Manager Settings.
The following are the properties to edit in SAP J2EE Engine Config Tool window:

Settings
HTTP Service
Compression

Actions and Notes
•

Change the values of the following properties as follows:
Server Î services Î servlet_jsp Î EnableZippedResponse = true
Server Î services Î http Î EnableZippedResponse = true

•

Change the values of the following property:
Server Î services Î http Î NotZippedFiles
To enable script files compression, remove the CSS and JS reference
from this line:
NotZippedFiles = .zip, .cs, .rar, .arj, .z, .gz, .tar, .lzh, .cab, .hqx, .ace, .jar,
.ear, .war, .css, .pdf, .js
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Change maximum length to 1024
MinimumGZipLength = 1024
Servlet_jsp Service
Compression

•

Server Î services Î servlet_jsp
•

HTTP Service
Content Expiration

Change the values of the following property:
Change maximum length to 1024, MinimumGZipLength = 1024

Sets the expiration for the static content in seconds. The default value for this
property is 86,400 seconds, or 24 hours. The recommended value is 604,800
seconds, or 7 days
•

Change the values of the following property:
Server Î services Î httpÎ CacheControl
Server Î services Î httpÎSapCacheControl

For example; CacheControl = 604,800

4.5

Using the SAP J2EE Engine Monitoring Server

SAP J2EE Engine contains a monitor server that provides valuable information of the state of the
system at runtime. We recommend that you use this monitoring tool during fine tuning tests.
For detailed information on how to run the monitor server, refer to the SAP J2EE Engine
administration guide, installed with SAP J2EE Engine Cluster.
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5 Tuning the Portal Platform
Various portal applications place information into different log files. We recommend that you disable
writing to log files in a production environment.
To disable logging for the portal applications, edit the following files:
File

Action and Notes

Logger.xml

Portal applications are configured according to the logger.xml configuration file.
Edit the logger.xml file by searching for the property isActive, and replacing its value in
each of the following directories, as follows:
isActive=”true” change to isActive=”false”.

system.log
and
default.trc

•

<J2EE Engine location>
/cluster/server/services/servlet_jsp/work/jspTemp/irj/root/
WEB-INF/portal/system/xml/logger.xml

•

<J2EE Engine location>
/cluster/server/services/servlet_jsp/work/jspTemp/irj/root/
WEB-INF/portal/portalapps/com.sap.portal.runtime.admin.logadmin/ logger/
logger.xml

•

<J2EE Engine location>
/cluster/server/services/servlet_jsp/work/jspTemp/irj/root/
WEB-INF/portal/portalapps/com.sap.portal.runtime.application.soap/logger/
logger.xml

A major performance improvement is achieved by disabling log files. These files are
written to the following directory:
<J2EE Engine location>/cluster/server/services/log/
To disable system.log:
1. Edit the saplogging.config file in the following directory:
<J2EE Engine location>/cluster/server/services/log/work/
2. Change the value /System.severity to NONE.
3. Change the value /Applications.severity to NONE
4. Change the line .logs = log[defaultTrace] to .localLogs = log[defaultTrace]
Reducing the application logs output level as described in this section also reduces
the output to the default.trc file.
5. Monitor the folder <J2EE Engine location>/cluster/server/log/ to make sure that
these log files are not created.

5.1

Turning Off Portal Monitoring

The portal contains several log services. One such log service uses Computing Center Management
System (CCMS) data collection server. If you are not using CCMS to collect and monitor the portal
data, you can disable the property for it.
To disable the monitor in a production environment:
1. Logon to the portal as an administrator.
2. In the top-level navigation bar, select System Administration > System Configuration.
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3. From the Detailed Navigation panel on the left, select Monitoring Configuration.
4. Under JARM, Java Application Responsetime Measurement in the Monitoring Configuration iView
on the right, uncheck the following:
−

Collect monitoring data

−

Write monitoring data to CCMS

5. Select Save in the iView.

5.2

Configuring Yahoo! Settings

If your portal works with content from Yahoo!, it is important to configure the Yahoo! settings to avoid
unnecessary requests.
To open the iView that contains Yahoo properties:
1. Logon to the portal as an administrator.
2. In the top-level navigation bar, select System Administration > System Configuration.
3. From the Detailed Navigation panel on the left, select Service Configuration.
4. In the Portal Catalog, under Browse, select and expand the Java class
com.sap.portal.yahoo > Services, and right click yahoo > Edit.
The following are the settings in the Property List iView that are relevant to performance:
Settings

Actions and Notes

Enable Connectivity to Yahoo!

Takes true or false.
Set it to false if you do not want connections to Yahoo.

Enable Persistent Heartbeat Pulses to
Yahoo!

Takes true or false.

Heartbeat Interval (in seconds)

The default value is 120.

Set it to false if you do not want connections to Yahoo.
If you are connecting to Yahoo, you may want to increase
this value.

Heartbeat Time-out (in seconds)

The default value is three.
If you are connecting to Yahoo, you may want to increase
this value.

Interval of Status Entry to Log File

The default value is 50.
If you are connecting to Yahoo, you may want to increase
this value.

5.3

Optimizing Content Catalog Administration

For administration tasks in the Portal Catalog, it is recommended that you organize the content in a
folder taxonomy.
Placing many objects in a single folder increases the time it takes for that folder to load.
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5.4

The PCD SQL Tracer

You can view and analyze PCD data using the PCD SQL Tracer. The PCD SQL Tracer utility provides
the following information:
•

Executed SQL statements

•

Frequency of an SQL statement execution.

•

Number of connections in the internal connection pool

By default the SQL trace is switched off. You can switch it on and off by setting the property
Pcd.Pl.TraceLevel.Sql in the pcdStartup.installer.properties file, in the folder:
<J2EE installation folder>/global/config/pcd
To switch the SQL trace on or off:
•

Set the property Pcd.Pl.TraceLevel.Sql to 3 if you want to trace the SQL information to the
pcd.log file.

•

Set the property Pcd.Pl.TraceLevel.Sql to 1 if you want to show the SQL trace information in
the console in addition to saving it to the pcd.log file.

5.4.1

Tracing Single Activities in the Portal

You can modify the configuration parameters of the PCD at runtime, as follows:

5.5

•

Start the component com.sap.portal.pcd.admintools.configuration.

•

Modify the configuration parameters in the pcdStartup.template.properties file.

•

Select the Reload button.

PRT Thread Management

The file prtDefault.properties contains various properties that can be configured for the PRT. You can
find the file in the folder:
<J2EE installation>/cluster/server/services/servlet_jsp/ work/jspTemp /irj/root/WEBINF/portal/system/properties
The following table shows the properties in the file prtDefault.properties, to configure for the PRT:
Setting

Action and Notes

loadlimit.requests

This property defines a limit for concurrent threads opened by the PRT.
The value must reflect the expected number of concurrent users, as a
concurrent user consumes one thread:
loadlimit.requests=100
In addition, the value of the property, in the file prtDefault.properties must
be the same as the value of the property MaxThreadCount of the SAP
J2EE Engine thread manager. See also Thread Manager Settings.

Async.Response.Pools.size

The number of buffers that the Page Builder can use to process
asynchronous rendering of pages.
async.response.pool.size=100
Each buffer is used during the rendering of a portal page. Increasing this
value increases the number of pages to be rendered asynchronously.
A large value can have significant effect on the system, as it is affected
by available system resources, such as memory.
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Setting

Action and Notes

PRT monitor

A useful setting is to enable the PRT monitor. You enable this monitor to
help identify bottlenecks in performance.
To enable the monitor:
•

Change the line "monitor.off=true” to “monitor.off=false”.

To view the monitor output:
•

Log on to the portal as an administrator, and navigate to:
System AdministrationÎMonitoringÎPortalÎComponents Overview
System AdministrationÎMonitoringÎPortalÎThreads Overview
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6 Tuning the System Database
Presently, this section contains information on Oracle systems.

6.1

Updating Classes12.jar

Classes12.jar contains the connectivity library for Oracle systems, and it must be updated to a specific
version.
You can locate the file, Classes12.jar in the following folder:
<J2EE installation>/server/additonal-lib/com/sap/jdbc_driver_references
Do the following:
•

Check the timestamp of the MANIFEST.MF file inside the classes12.jar file, by running the
following command:
>unzip -l classes12.jar | grep MANIFEST.MF
The timestamp should not be older than- “02-19-03 15:28”
If the file is older than indicated, download an updated classes12.jar file from Oracle Web site,
and replace the old one.

For more information, refer to the guide EP6.0 SP1 Installation Guide (Portal, CM, TREX, Unification),
at: http://service.sap.com, and navigate to Enterprise Portal 6.0 > Documentation & More >
Installation.
Check also SAP Note 580304 for updates on this JAR file.
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7 Tuning the LDAP Directory
7.1

LDAP Connection Pool

Enterprise Portal 6.0 uses an LDAP connection pool to recycle calls made to the directory. The default
connection pool property, ume.ldap.connection_pool.max_size, has a value,
ume.ldap.connection_pool.max_size = 10, that enables 50 concurrent logins.
When you change the value of the property to ume.ldap.connection_pool.max_size = 20, you
enable 100 concurrent logins.
To change the value of this property:
1. Open and edit the file sapum.properties, from the path:
/usr/sap/<system name>/j2ee/j2ee_<instance number>/ume/.
2. Change the value of the property ume.ldap.connection_pool.max_size.

To support the required number of concurrent logins, the MaxThreadCount property in the
Thread Manager of the SAP J2EE Engine, must be equal to the number of concurrent logins
in the property, loadlimit.requests of the PRT, as one thread equals one concurrent request.
See also the sections on Thread Manager Settings, and PRT Thread Management.
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8 Tuning the Browser
Configuring the browser and front-end devices for the portal leads to increase performance in the
processes of the portal.

8.1

Setting the Browser for Compression

When using the Microsoft Internet Explorer as client browser, you must activate the HTTP 1.1 setting
for the SAP Enterprise Portal compression filter to work.
To set the compression filter:
1. From the client browser menu bar, select Tools and then Internet Options.
2. Choose the Advanced tab and scroll to HTTP 1.1 settings.
3. Make sure the Use HTTP 1.1 checkbox is selected.
4. If your network operates with a proxy server, verify that Use HTTP 1.1 through proxy connections
is also selected.
5. Click OK.
The following table contains browser caching information:
Browser Settings

Actions

MS Internet Explorer 5.0, 5.5, 6.0

Browser Caching
You can improve the browser response time by using the browser
cache. This enables your browser to cache resource files such as
images, CSS, JS, txt, and many more.
For detailed information on browser caching, refer to the section
on Accessing the Enterprise Portal under the topic Setting Internet
Browser Options in the End User Guide at:
http://help.sap.com > mySAP Enterprise Portal > SAP
Enterprise Portal .
To use the browser cache in Internet Explorer (IE):
1. From the Tools menu > Internet Options > General tab, click
Settings.
2. Under Check for newer versions of stored pages in the
Settings dialog box, select either Automatically or Every Time
you start Internet Explorer.

Do not choose Every visit to page.
3. Click OK twice to save the settings for the browser cache.
Netscape 6.x

Browser Caching
In Netscape 6.x, you can improve the browser response time by
using the browser cache.
To use the browser cache in Netscape:
1. From the Edit menu, select Preferences.
2. In Category, click Advanced Cache.
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Browser Settings

Actions
3. Under Document in cache is compared to document in
network in the Cache pane, select either Never or Once per
session.

Do not choose Every time.
4. Click OK to save the settings for the browser cache.
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JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for
technology invented and implemented by Netscape.
MarketSet and Enterprise Buyer are jointly owned trademarks of SAP AG and Commerce One.
SAP, SAP Logo, R/2, R/3, mySAP, mySAP.com and other SAP products and services mentioned
herein as well as their respective logos are trademarks or registered trademarks of SAP AG in
Germany and in several other countries all over the world. All other product and service names
mentioned are trademarks of their respective companies.
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